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Copyright Notice 
 
No part of this publication may be copied, transmitted, stored in a 
retrieval system, or translated into any language in any form or by 
any means without the express written permission of FarStone 
Technology Inc. 
 
FarStone grants you the right to use one copy of the enclosed 
software program ("SOFTWARE") on a single computer. If the 
SOFTWARE is installed on a network, or more than one user can 
run the SOFTWARE at the same time, you must purchase an 
additional license for each additional user or computer. 
 
Trademarks 
 
FarStone®, VirtualDrive®, VirtualDrive® Network and 
VirtualDrive® Professional are trademarks of FarStone Technology, 
Inc.  
 
Microsoft®, Windows® and MS-DOS® are registered trademarks 
of Microsoft Corporation. Other product names mentioned in this 
User’s Guide may be trademarks or registered trademarks of their 
respective companies. 
 
FarStone Technology, Inc.  
U.S. Headquarters: 
1758-B North Shoreline Blvd 
Mountain View, CA 94043 
Phone: (650)969-4567 
Fax: (650)968-4567 
 
Asia-Pacific Offices: 
10F-1B, No. 207, DunHua North Rd., Taipei, 105, Taiwan 
Phone: 886-2-2546-9898 
Fax: 886-2-2546-3838 
 
Technical support: 
 
Please contact your retailer, or use our online support system at 



  

www.farstone.com/support/. 
 
For your convenience, you will find answers to frequently asked 
questions on our website at www.farstone.com/support/faqs/. 
Follow the links to the support section or contact a technical 
support representative: 
http://www.farstone.com/home/en/shtml/contactus.shtml.  
Copyright© 2001-2010 FarStone Technology Inc. All rights 
reserved. 

http://www.farstone.com/home/en/shtml/contactus.shtml
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Software License Agreement 

FARSTONE TECHNOLOGY, INC. (FARSTONE) END USER LICENSE 
AGREEMENT FOR VirtualDrive Network, HEREAFTER REFERRED TO 
AS THE "SOFTWARE"  

PLEASE READ CAREFULLY: THE USE OF THIS "SOFTWARE" IS 
SUBJECT TO THE "SOFTWARE" LICENSE TERMS OF FARSTONE 
AND OTHER LICENSORS WHOSE SOFTWARE MAY BE BUNDLED 
WITH THIS PRODUCT.  

BY YOUR USE OF THE "SOFTWARE" INCLUDED WITH THIS 
PRODUCT YOU AGREE TO THE LICENSE TERMS REQUIRED BY THE 
LICENSOR OF THE "SOFTWARE", AS SET FORTH BELOW. IF YOU 
DO NOT AGREE TO THE LICENSE TERMS APPLICABLE TO THE 
"SOFTWARE", YOU MAY RETURN THE ENTIRE UNUSED PRODUCT 
FOR A FULL REFUND.  

LICENSE AND WARRANTY:  

The software which accompanies this license (the "Software") is 
the property of FARSTONE or its licensors and is protected by 
copyright law. While FARSTONE continues to own the Software, 
you will have certain rights to use the Software after your 
acceptance of this license. Except as may be modified by a license 
addendum which accompanies this license, your rights and 
obligations with respect to the use of this Software are as follows:  

A. Single User License:  

(a) use the "Software" on a single computer system or network, 
and only by a single user at a time. If you wish to use the 
"Software" for more users, you will need an additional License for 
each user.  

(b) make one copy of the "Software" in machine-readable form 
solely for back-up purposes, provided you reproduce FarStone's 
copyright proprietary legends. Notwithstanding the foregoing, the 



  

"Software" may be used on the home, laptop or other secondary 
computer of the principal user of the "Software", and an additional 
copy of the "Software" may be made to support such use. As used 
in this License, the "Software" is "in use" when it is either loaded 
into RAM or installed on a hard disk or other permanent memory 
device. The "Software" may be "in use" on only one computer at 
any given time. (Different License terms and fees are applicable 
for networked or multiple user applications.) As a specific condition 
of this License, you agree to use the "Software" in compliance with 
all applicable laws, including copyright laws, and that you will not 
copy, transmit, perform or distribute any audio or other content 
using the "Software" without obtaining all necessary Licenses or 
permissions from the owner of the content.  

B. Multiple User License:  

Make one copy of the "Software" in machine-readable form solely 
for back-up purposes, provided you reproduce FarStone's copyright 
proprietary legends.  

You must acquire and dedicate a License for each separate 
computer on which any part or portion of the "Software" is 
installed or run As used in this License, the "Software" or any part 
or portion of the "Software" is "in use" when it is either loaded into 
RAM or installed on a hard disk or other permanent memory device 
including any networked or shared environment where either direct 
or indirect connections are made through software or hardware 
which pools or aggregates connections.  

As a specific condition of this License, you agree to use the 
"Software" in compliance with all applicable laws, including 
copyright laws, and that you will not copy, transmit, perform or 
distribute any audio or other content using the "Software" without 
obtaining all necessary Licenses or permissions from the owner of 
the content.  

C. Restrictions:  

You may not distribute copies of the "Software" to others or 
electronically transfer the "Software" from one computer to 
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another over a network. You may not post or otherwise make 
available the "Software", or any portion thereof, in any form, on 
the Internet. You may not use the "Software" in a computer 
service business, including in time-sharing applications. The 
"Software" contains trade secrets and, in order to protect them, 
you may not decompile, reverse engineer, disassemble, or 
otherwise reduce the "Software" to a human-perceivable form. 
YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN, 
RESELL FOR PROFIT, DISTRIBUTE, NETWORK OR CREATE 
DERIVATIVE WORKS BASED UPON THE "SOFTWARE" OR ANY PART 
THEREOF.  

D. Limited Warranty:  

Farstone warrants that the media on which the Software is 
distributed will be free from defects for a period of thirty (30) days 
from the date of delivery of the Software to you. Your sole remedy 
in the event of a breach of this warranty will be that Farstone will, 
at its option, replace any defective media returned to Farstone 
within the warranty period or refund the money you paid for the 
Software. Farstone does not warrant that the Software will meet 
your requirements or that operation of the Software will be 
uninterrupted or that the Software will be error-free.  

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. THIS WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE TO STATE.  

E. Limitation of Liability:  

IN NO EVENT WILL FARSTONE OR ITS LICENSORS BE LIABLE TO 
YOU FOR ANY INCIDENTAL, CONSEQUENTIAL OR INDIRECT 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR 
LOSS OF DATA, EVEN IF FARSTONE OR A LICENSOR HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. Some states do not allow the 



  

exclusion or limitation of special, incidental, or consequential 
damages, so the above limitation or exclusion may not apply to 
you.  

F. General:  

You acknowledge that you have read this Agreement, understand it, 
and that by using the "Software" you agree to be bound by its 
terms and conditions. You further agree that it is the complete and 
exclusive statement of the agreement between FarStone and you, 
and supersedes any proposal or prior agreement, oral or written, 
and any other communication between FarStone and you relating 
to the subject matter of this Agreement. No additional or any 
different terms will be enforceable against FarStone unless 
FarStone gives its express consent, including an express waiver of 
the terms of this Agreement, in writing signed by an officer of 
FarStone. You assume full responsibility for the use of the 
"Software" and agree to use the "Software" legally and responsibly.  

Should any provision of this Agreement be declared unenforceable 
in any jurisdiction, then such provision shall be deemed severable 
from this Agreement and shall not affect the remainder hereof. 
FarStone reserves all rights in the “Software” not specifically 
granted in this Agreement.  

Should you have any questions concerning this Agreement, you 
may contact FarStone by writing to:  

FarStone Technology, Inc.  

350 S Hope Ave, Suite A103 
Santa Barbara, CA 93105 
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Chapter 1 Introduction                         
1.1 What is VirtualDrive® Network　 

VirtualDrive Network (VDN) from FarStone Technology Inc., 
includes the VDN Server, VDN Administrator and VDN Client 
programs. VCDs created using the VDN Administrator program can 
be stored on your network and run on Client PCs or Workstations 
using the VDN Client program. 

The VDN Administrator can turn your CDs into VCDs that will run 
on the VDN Client just like if it were in a physical CD drive. 

 

You can create up to 23 Virtual CD/DVD Drives that are accessible 
through Windows Explorer just like a regular physical CD/DVD 
Drive.  You no longer need to change CDs by hand, deal with the 
hassle of trying to find them, and keeping them clean and working. 
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1.2 Features and benefit 

1. Runs applications without CD-ROM:  

Select and insert a VCD into the VirtualDrive and the VCD appears 
as though a CD is actually in a physical CD drive. 

2. Supports most disc formats, including: 

CD-ROM, Audio CD, DVD-ROM, DVD-Video, Video CD, Mixed-Mode 
CD, Multi-Session CD, CD-Extra, CD-Text and Photo CD. 

3. Automatically recognize CD format 

VirtualDrive can distinguish the type and format of the CD it is 
compressing, and run the correct program. 

4. Faster than a 200X CD-ROM drive: 

Run CDs directly from the hard drive with incredible 200X speed. 
(with Ultra DMA drives) 

5. 1000 Virtual Jukeboxes:  

VirtualDrive Network supports up to 1000 Virtual CD Jukeboxes 
(CD folders), with each folder able to hold an unlimited number of 
CDs. 

6. Burn your VCDs onto a recordable disc  

VirtualDrive combines the functions of CD/DVD emulation software 
with CD/DVD burning capabilities. It allows users to copy CD/DVD 
images from the hard disk to a recordable medium.  

7. Easy Management:  

The Administrator creates and configures the VirtualDrive Network. 
Changes affect clients instantly. Clients have no need to worry 
about the details. VirtualDrive doesn't copy hundreds of thousands 
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of files from the CD. Rather, it actually creates a CD image file on 
the hard drive. Only this image file needs to be created or 
removed. 

8. Compression:  

VirtualDrive incorporates a high performance compression engine 
and automatically decompresses on the fly when the VCD is 
accessed. 

9. Command Line Support:  

You can access VirtualDrive and run VCDs using the command line 
interface or batch files. For example, you can write batch files to 
mount a VCD and open a specific program for different users. 

10. Removable media:  

VCD files can be placed on many different types of removable 
media extending the capability of such systems. 

11. Saves space and hardware costs: 

Take no physical space in your office and has no hardware 
maintenance costs.  

12. 100% compatible:  

VirtualDrive is completely compatible with all types of CD 
applications. Some CD applications only run (lock) from a physical 
CD drive. These applications will not run from a mapped network 
drive, like a drive mapped to your server CD drive (or Jukebox). 
VDN supports all such CD applications. 

13. Share Resources:  

Storing Virtual CD’s on a file server allows CD resources to be 
shared throughout the network. 



  

14. Built in CD benchmark and browser: 

Evaluate the data transfer rate and access time for any of your CD 
drive(s). 

15. CD Audio Compression:  

Listening to your favorite music has never been easier. Just select 
the tracks you like and they will be automatically compressed and 
converted to an VCD file.  

16. VirtualDrive Custom AUTORUN feature:  

VirtualDrive Network provides a (built-in) comprehensive way to 
automatically startup VCDs. 

17. Create Custom Virtual CDs from selected files:  

Customize your own VCDs by removing unnecessary files from the 
source CD. 

18. Easy CD Management:  

Organize CDs' and manage all CD access from a single workstation. 

19. Security 

The VirtualDrive Network can set security properties according to 
clients’ demand. Each client can only use the Virtual CD authorized 
by administrator. 

20. MP3  

If Windows Media Player MP3 subassembly or other MP3 
code/decode programs are installed in system, you may compress 
audio CD into MP3 files. 
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21. ISO Support  

VirtualDrive Network supports the ISO image file format, so you 
can transfer you data more conveniently. 



  

 
1.3 Benefits for Schools and Businesses 
 
Benefits for Schools   

1. Easy management: As many as 500 CD-ROMs may be needed 
for a class with 25 computers and 20 educational CD titles. With 
VDN you no longer have to manage all the discs and worry about 
damaged discs or losing them.  You only need one copy of each 
title to create a VCD image.  

2. Client machines don’t need CD/DVD drive: Students are 
unable to install their own personal CD software.  You save 
money by buying computers without CD/DVD Drives. 

3. The VDN Server: Everyone has 24/7 access to the VCDs on the 
server from any computer on the network. 

Benefits for Businesses   

1. RD departments: Information is at your fingertips. Keep 
everything on the VDN CD server such as MSDN resource CDs, 
and reference guides. 

2. Education: Employee trainings can be more efficient and cost 
effective by storing training materials on the VDN Server. 

3. Information Management: The amount of data to be stored is 
always increasing. VDN CD server can be used to efficiently 
manage data resources or totally replace CD Jukeboxes systems. 
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Chapter 2 Installing VDN                                
 

2.1 System requirements 

1. VDN Server directory 
    Windows XP/Server 2003/Vista/Server2008 (32-bit & x64) 
/Windows 7 
    7 MB HDD space 

2. VDN Administrator: 
    Windows XP/ Server 2003/Vista/Server2008 (32-bit & x64)    
/Windows 7 
   A CD drive  
   7 MB HDD space if working peer to peer 

3. VDN Clients: 
    Windows XP/Server 2003/Vista/Server2008 (32-bit & x64) / 
Windows 7  
    No CD drive is required. 

 

 Note 
VDN supports Windows and Novell long file names. If 
your Novell server does not support long file names, 
use Dos 8.3 file naming conventions for VCD files. 
 
To install VirtualDrive Network successfully, you should 
notice the following three points: 
 
a. The Network Framework on your operating system 

is Network Framework 2.0 or higher. 
b. The Windows Installer on your operating system is 

Windows Installer 3.1 or higher. 
c. The SQL Server on your operating system is SQL 

Server 2005 Express Edition or higher. 
Otherwise, you will be prompted to install those three 



  

programs during the installation. 

2.2 Installing the VDN (VirtualDrive Network) 
Server 
 
Pre-Installation    

Be sure to install the VDN components according to the following order: Please 
install VDN Server first, then VDN Administrator/VDN Client Module. Make sure 
that VDN Server works normally during the installation of VDN Administrator 
and VDN Client Module. 

Follows the steps below to install VDN Server:  

Step 1 Insert the VDN CD into the CD drive and run the VDN 
installation program (Setup.exe). Following the popup screen 
guides to install .NET Framework 2.0, Windows Installer 3.1or SQL 
Server 2005 Express if necessary.  

Step 2 Select your language preference and click OK. 

Step 3 Click Next to continue. 

Step 4 Carefully read the License Agreement and select Yes, if 
you accept the license conditions. 

Step 5 Enter your personal information and then click Next to 
proceed. 

Step 6 Select the installation location(e.g.C:). And then click Next to begin 
the installation.  

Step 7 Select whether you will restart your computer right now. 
And then click Finish to complete installation of the VirtualDrive® 
Network program files. 

Step 8 Click Yes to restart the computer right now, or click No to 
restart computer later.  



  

Step 9 After the installation completes, share(Manually) the VDN Server 
installation directory correctly as the following rules: 

    

Important !  

a.   Share the entire installation directory(e.g. 
C:\VDN) as Read Only to everyone within LAN.  

b. Share the sub-directory C:\VDN\FsvdnData$ as 
Read/Write to everyone. Make sure the share name 
is the same as FsvdnData$. 

c. Shared folder setting in Windows 7 platform 

Select Fsvdndata$ folder, then right-click and select 
Propertities; select ‘Sharing’ tab; click ‘Advanced 
Sharing’ button to enter Advanced Sharing setting 
console; then select ‘Share this folder’ checkbox, and 
make sure the share name is the same as 
FsvdnData$, click OK; after successful setting, the 
path is set to be  as \\Machinename\Fsvdndata$ 

 

You will need these two shared directories to install the VDN Administrator/ 
VDN Client, and make those two work properly. So it is suggested that you 
check the share setting prior to installing the other two components.                       

 
2.4 Installing the VDN Administrator or Client 
programs 
 
Once the VDN Server have been installed into a shared directory, 
both the VDN Administrator and the VDN Client installations can be 
executed by running the setup.exe file from the VDN Server 
shared directory.  There are two methods to install the VDN Admin 
and Client programs ---manual installation and silent installation.  
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Follow the steps below to run manual installation: 
 
Step 1 Select Start on the Windows taskbar, then Run. 
 
Step 2 Enter the UNC path to the setup program, the 'shared' VDN 
Server directory.  
 

 Note 
The shared VDN Sever directory is composed of the 
computer name and shared folder name where 
VirtualDrive® Network sever program is installed. (e.g. 
\\server\vdn\setup). The “sever” is the computer 
name, and "vdn" is the shared folder name. 

 
 

 
Step 3 Click Run to launch the VDN Setup Wizard.  Following the 
popup screen guides to install Network Framework 2.0, Windows 
Installer 3.1or SQL Server 2005 Express if necessary. 
 
Step 4 Click Next to continue. 
 
Step 5 Select Default Installation or Customized Installation 
according to the popup hint in the window. The window is shown 
as below. 
 



  

 
 
2.4.1 Default Installation 
 
If you select Default Installation in the last step, please do the 
following steps to complete the installation. 
 
Step 1 Carefully read the License Agreement and select I accept 
the terms in the license agreement, if you accept the 
conditions. Click Next to continue.  
 
Step 2 Enter your personal information and click Next. 
 
Step3 The Install Wizard will suggest a folder to install the 
VirtualDrive® Network program files. If you would like to store the 
program files in another location, select Change to open the file 
browser and select a new folder. 
 
Step 4 Click Next to continue. 
 
Step 5 Check the box to set the number of virtual drives in the 
system. You must select at least one drive to install VirtualDrive®. 
Then click Next. 
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Step 6 Click Install after you confirm all the settings you 
configure. You can also click Back to change your settings as you 
want. 
 
Step 7 You can launch VirtualDrive® Network manager and/or 
place a shortcut on the desktop after installation by selecting the 
checkboxes. Select Finish to complete the installation. 
 
Step 8 Click Yes to restart the computer right now, or click No to 
restart computer later. 
 
 
2.4.2 Customized Installation 
 
If you select Customized Installation in the last step, please do 
the following steps to complete the installation. 
 
Step 1 Select either to install the VirtualDrive Network Client 
and/or the VirtualDrive Network Administrator. 
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Step2 Click Next to continue. 
 

 Note 
Selecting Install VirtualDrive Network Client will 
install the VDN Client program only. You need to do the 
following steps.  

 
Step 3 Carefully read the License Agreement and select I accept 
the terms in the license agreement, if you accept the 
conditions. 
 
Step 4 Enter your personal information and click Next. Selecting 
Install VDN Administrator will require you to enter the product 
serial number: You will use an evaluation version without a product 
serial number. 
 

 Note 
If you need to reinstall VirtualDrive Network 
Administrator, you must reactivate the software.  

 
Step 5 The Install Wizard will suggest a folder to install the 
VirtualDrive® Network program files. If you would like to store the 
program files in another location, select Change to open the file 
browser and select a new folder. 
 



  

 
 
Step 6 Click Next to continue. 
 
Step 7 Check the box to set the number of virtual drives in the 
system. You must select at least one drive to install VirtualDrive®. 
Then click Next. 
 
Step 8 Click Install after you confirm all the settings you 
configure. You can also click Back to change your settings as you 
want. 
 
Step 9 You can launch VirtualDrive® Network manager and/or 
place a shortcut on the desktop after installation by selecting the 
checkboxes. Select Finish to complete the installation. 
 
Step 10 Click Yes to restart the computer right now, or click No 
to restart computer later. 
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Chapter 3 Using the VDN 
Administrator Program                
 
 
3.1 Starting the VDN Administrator 

The “VirtualDrive” icon will be displayed in the bottom-right corner 
in the Windows Taskbar after the VDN administrator program is 
successfully installed on the administrator workstation. 

 

To start the VDN Administrator program, double click on the 
VirtualDrive tray icon or right click on the tray icon and select 
“VirtualDrive Network Administrator”. 

 

  

Click Continue and a dialog box will pop up: 

                                                                        



 

 

   

Note 
The default password is nothing.  

Click OK and you will enter the Administrator console: 

 
 

     Figure 3.2 
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3.1.1 The VDN Administrator Manager 

Toolbar: 

 

The above figure is the default toolbar of VDN Administrator. You 
can customize the toolbar by selecting  
View -> Settings -> Customize (figure below). 

 

 
 
3.1.2 VDN Right-Click Menu in Taskbar 

After successfully installing the VDN Administrator program on the 
administrator workstation, the “VirtualDrive” icon will be displayed 
at the bottom-right corner in the Windows Taskbar. 

   

Right-click on this icon will open the figure: 



 

 

• VirtualDrive Administrator: Launch VDN admiinstrator 

• VirtualDrive Client: Launch VDN Client 

• Rapid Cache: Run Rapid Cache 

• Build: Build VCD directly 

• Customize: Build VCD from selected files 

• Browse: Check the number of virtual drives and inserted CD    
information 

• Drives: Set the number of virtual drives 

• Exit: Quit VirtualDrive Network 

 
 
3.1.3 Administrator Settings 

Changing the Password 
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You can set or change the password to the VDN Administrator by 
selecting 'Security' on the menu bar. Then select 'Password'. 

You will be required to enter the current Administrator Password, 
type in the new password and then re-enter the new password to 
confirm.  

Administrator Setup -Toolbar 

To open the Administrator Settings dialog, select View on the 
menu bar then Settings. 



 

 

The available Toolbar settings are described below: 

Use large Icons: Sets the size of the buttons icons on the toolbar. 

Show button Name: Sets the number of text characters to be 
displayed within the toolbar buttons. 

Show Tool Tip Text: Sets whether to display control tips popup, 
when the mouse pointer hovers over a toolbar button. 

Use Flat Toolbar Buttons: Merges the toolbar button “outline” 
into the toolbar. 

Customize: Clicking on 'Customize' button, opens a dialog 
offering a selection of buttons available within the VDN 
Administrator. From here you can add/remove or change the order 
of toolbar buttons used on the VirtualDrive toolbar. 
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Administrator Setup- Other Settings 

To open the Administrator Settings dialog, select File on the menu 
bar then Settings and select the 'Other' Tab. 

 

Descriptions of the Other Settings are given below: 

Show VirtualDrive splash screen at startup: Displays the 
VirtualDrive logo as the program loads. 

Add VirtualDrive icon to the system tray: Adds the 
VirtualDrive icon to the bottom right hand side of the Windows 
taskbar. 

Keep VirtualDrive always on top: Keeps the VirtualDrive 
interface always visible. ie: above all other application windows 



 

Verify the authority for VCD folder: Enables the Password 
dialog on client side computers. 

Administrator Setup- Build Size Settings 

From here, you can set the volume size from 1MB to 2048MB for 
each virtual CD. This feature is designed for building large size files 
only, e.g. building customized files and DVD. If the file you are 
building exceed the size you set, the remainder will be created as 
*.D (01,02…). 

 

  

Recording options 
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• Shut down computer after task is completed: 
VirtualDrive will turn off your computer after the Building 
Image or Burning Image process is complete.  

• Eject disc after recording is completed: VirtualDrive will 
eject the disc from the CD recorder once the build operation 
is complete.  

• Write Image Reader on the disc: VirtualDrive burns the 
image, which is created from a physical CD, to the re-
writable medium.  The use of the images burned on the disc 
requires the support of a virtual drive.  Therefore, you still 
need either VirtualDrive or another emulation program 
installed on the PC where the disc is to be used. The Image 
Reader program can help you to create a virtual drive on 
the computer system.  

• Delete temporary CD image after task is completed: 
This option is designed for the Copy Disc feature.  You can 
choose whether to remove the temporary image file, which 
is created during the “Building Image” process, or keep it 
after the burning process is complete.  
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• Change image location: Specify a location on your hard 
disk to hold the temporary image file that is created in the 
Copy Disc section. 

 
 
3.3 Building Virtual CDs (VCDs)  
 
3.3.1 Building VCDs from the CD Drive 

To use VirtualDrive, you must first create an image of a CD on 
your hard drive.  This image is known as a Virtual CD or VCD. You 
can build a VCD from almost any type of CD, including: 

• CD-ROM • Audio CD • DVD-Video 

•  DVD-ROM •  Video CD • Mixed Mode CD 

• CD Extra  •  Photo CD • Multi-Session CD 

• CD Text • CD Cops  

VirtualDrive supports DVD-ROM games, encyclopedias, multi-
media content, and other very large file formats. 

You can begin to build a VCD, using one of the following methods: 

1. Select Making Image on the toolbar. 

2. Select File from the menu bar and select Making Image. 

3. Right-click the VirtualDrive icon in the system tray and select 
Make Image. 

4. Use the shortcut key Ctrl+B. 

Note: These are the steps for building a VCD from a CD-ROM, 
DVD-ROM, Video CD, DVD-Video, Multi-Session CD or Photo CD. To 



  

build a VCD from an Audio CD, see Section 4.3 or to build a VCD 
from a Mixed-Mode CD, see Section 4.4. 

Step 1 Select the physical CD drive then click on Next. 

 

Step 2 Check that the selected hard drive has sufficient “Free 
Space” (Figure 3-3a)to store the new VCD.  Then use the File 
Browser to select a location to save the VCD and give the new VCD 
file a name. If no new name is entered then the new VCD will use 
the name of the folder in which it is to be stored, as the VCD file 
name. 



 

 

                                                    3-3a 

Step 3 Select the CD read method and whether to use data 
compression or not. 

You can use the Intelligent Extraction to build your VCDs in 
most cases.  Some CDs must be built using Other Protect CD 
Type due to CD Encryption.  If you know which protection type is 
on the CD, you can choose to build with that protection type from 
the dropdown list.   

Using data compression will save hard disk space but will require a 
longer VCD build time.   
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Step 4 Enter a Description of the new VCD in the Description 
box(Figure 3-3b). 

 



 

 

                                           Figure 3-3b 

Step 5 (optional) If the CD does not have an Auto-Run the you 
can specify a program to run when the VCD is Inserted. 

You can use the Browse button to locate the executable 
program. 

Step 6 (optional) Choose whether or not to eject the CD from the 
CD drive once the Build is complete by checking the ‘Eject the VCD 
on completion of the Build process’ box (Figure above). Click on 
Next to continue.   

Step 7 Click on Next to open the Build window. Virtual Drive will 
then display the attributes of the VCD about to be created.  
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Step 8 With the VCD is successfully built, click on OK to exit the 
Build popup then click on Finish to close the VCD Build 
window( Figure 3-3c). 



 

 

 

 

                                               Figure 3-3c 

 
3.3.2 Building VCDs from Selected Files 

Create a VCD from files on your hard drive by any of the following 
methods.   

1. Click on the Customize button  on the toolbar.  
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2. Select File from the menu bar and choose Customized. 

3. Right click the VirtualDrive icon in the System tray and selecting 
Customized from the popup menu. 

Then follow the steps as described below. 

Step 1 Add the files/folders you want included in the new VCD. 

There are three ways that files can be added to the VCD.   

Method 1 Drag selected files (folders) from top frame and drop 
them into bottom frame of the Customize window 
 
Method 2 Copy selected files (folders) and them into the bottom 
frame of the Customize window. 

Method 3 Click the Add   button to open the VirtualDrive file 
manager.   

VirtualDrive supports VCD files up to 18 Gigabytes in size. 



 

   

Note 
VCD files created using this method are subject to the 
ISO9660 standard. See Appendix-Notes for details.  

The current attributes of the new VCD can be previewed by right-
clicking the CD icon in bottom-left frame and select Properties 
from the drop menu. 
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Step 2 Designate a location to save the VCD. 

Once you have finished adding files, click the Make 

Image button. 

You will be prompted to give the new virtual CD file a name. Enter 
the name and click Save to open the VCD Build window     

                             

Step 3 Select the CD Read method and whether to use data 
compression if desired. 

You can use the Intelligent Extraction to build your VCDs in 
most cases.  Some CDs must be built using Other Protect CD 
Type due to CD Encryption.  If you know which protection type is 
on the CD, you can choose to build with that protection type from 
the dropdown list. 



 

Using data compression will save hard disk space but will require a 
longer VCD build time.   

 

  

 

Step 4 Enter a Description of the new VCD in the Description box. 
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Step 5 (optional) If the CD does not have an Auto-Run then you 
can specify a program to run when the VCD is inserted. You can 

use the Browse button to locate the executable program. 

Step 6 (optional) Choose whether or not to eject the CD from the 
CD drive once the Build is complete by checking the ‘Eject the VCD 
on completion of the Build process’ box (Figure above). Click on 
Next to continue.   

 

Step 7 Click on Next to begin the building. Virtual Drive will then 
display the attributes of the VCD about to be created.  



 

 

Step 8 When the VCD has been successfully built, click on OK to 
exit the Build popup then click on Finish to close the VCD Build 
window. 
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3.3.3 Building VCDs from Audio CD-ROMs 

To create an audio VCD, open the Build VCD dialog box by 5 
methods. 

(a) Click on the Make Image button  on the toolbar. 

(b) Select File from the menu bar and choose Make Image from 
the drop menu 

(c) Right click on the VirtualDrive icon in the System tray and 
select Make Image. 

(d) Using shortcut key Ctrl+B.   

Then follow the steps as described below. 

   

Note 
VirtualDrive will automatically detect the CD type and run 
the Build Audio VCD process. 

 



 

 

Step 1 Select the physical CD drive then click on Next. 

Step 2 Check that selected hard drive has sufficient ‘Free Space’ 
(Figure 3-3-3a) to store the new VCD.  
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                                          Figure 3-3-3a 

Step 3 Use the File Browser button (Figure 3-3-3a) to select a 
location to save the VCD.   

Step 4 Give the new VCD file a name and click on Next (Figure 3-
3-3a).   

   

Note 
If no new name is entered then the new VCD will use the 
name of the folder in which it is to be stored, as the VCD 
file name.   

 

Step 5 Select the tracks you want to include on the Audio VCD by 
clicking on the check boxes of Tracks column. 



 

Note: If the CD player is running the Track selection will not be 
able to view the track list. 

 

                                      Figure 3-3-3b 

 

Step 6 Set the Preview track 

If you don’t need to build all tracks, you can click on the Preview 

track play  button to select which track you like to build and 

click on the Volume  button to set the Preview track’s 
level (Figure 3-3-3b above). When you select one track and click 

on the Preview track play  button, you can see the track’s 
playing progress bar from Progress. 

 50 



  

 

Audio settings-Step 3 Save your settings. 

Any combination of settings provided in the "Sound Selection" 
window can be saved to a file by clicking on the "Save As" button 
and giving your custom audio settings a Name. The next time 
you open the "Sound Selection" window this name will be 
presented as a choice in the "Name" selection box. 

Step 7 Add a description for the new Audio VCD. 

Note: This is not the VCD file name. 

 

                                       Figure 3-3-3i 

Step 8 To Auto-Run the Audio VCD when it is inserted into a 
VirtualDrive, you should specify a program to run when the VCD 



 

is loaded. To do this, click on the file Browser button and 
select an appropriate multi-media program. 

Figure 4-3i above, shows the Windows Cdplayer.exe has been 
chosen to play the Audio VCD. 

Step 10 Check the 'Eject the VCD' check box (Figure 3-3-3i 
above) if you want the CD to be ejected from the CD drive. When 
the Build has competed, then click on Next to open the System 
Settings dialog. From here you can review the chosen VCD 
attributes. To continue, click on Next to open the Build VCD 
window(Figure 3-3-3j). 

 

Step 11 If any audio player application is using the physical 
drive, close it now and begin building the Audio VCD. 
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                                   Figure 3-3-3j 

Step 12 With the VCD successfully built, click on OK to exit the 
Build popup then click on Finish to close the VCD Build 
window(Figure 3-3-3k)  

 



 

 

                                 Figure 3-3-3k 

 
3.3.4 Building VCDs from Mixed-Mode CDs 

To create a Mixed Mode VCD, open the Build VCD dialog box by 5 
methods. 

(a) Click on the Make Image button on the toolbar. 

(b) Select File from the menu bar and choose Make Image from 
the drop menu. 

(c) Right click on the VirtualDrive icon in the System tray and 
selects Make Image. 

(d) Using the shortcut key Ctrl+B.   
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Then follow the steps as described below. 

Step 1 Select the physical CD drive then click on Next. 

 

Step 2 Check that selected hard drive has sufficient ‘Free Space’ 
(Figure 3-3-4a) to store the new VCD.  Use the File Browser to 
select a location to save the VCD and give the new VCD file a 
name. If no new name is entered then the new VCD will use the 
name of the folder in which it is to be stored, as the VCD file 



 

name.  

  

     Figure 3-3-4a 

 Step 3 Select the CD Read method and the CD Record method 
(Figure 3-3-4b). 
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Figure 3-3-4b 

 The default read method is 'Normal' and it is successful for most 
CD formats however, because some CDs contain inaccurate 
volume information, use the 'Intelligent extraction' method if a 
VCD has been successfully built but does not run properly.  

You can use the Intelligent Extraction to build your VCDs in 
most cases.  Some CDs must be built using Other Protect CD 
Type due to CD Encryption.  If you know which protection type is 
on the CD, you can choose to build with that protection type from 
the dropdown list. 

Using Data Compression will save hard disk space but will require 
a longer VCD build time. 

If you only select ‘Record Data Tracks’, VDN will ONLY build the 
Data Tracks of the selected Mixed Mode CDs.  If ‘Record Audio 
Tracks’ is selected, VDN will ONLY build the Audio Tracks of the 
selected Mixed Mode CDs as background music. If both ‘Record 



 

Data Tracks’ and ‘Record Audio Tracks’ are selected then VDN 
Will build the Data Tracks and Audio Tracks of the selected Mixed 
Mode CDs. 

               

Step 4 Set the Preview track 

As long as you have selected ‘Record Audio Tracks’ and click 
Next button, VDN will open the ‘Select Tracks’ window(Figure 3-
3-4c). If you are only selecting ‘Record Audio Tracks,’ skip step 
4 and go to step 5. 

If you don’t need all Audio tracks, you can click on the Preview 

track play  button to select which track you like to build and 

click on the Volume   button to set the Preview track’s 
level. When you select one track and click on the Preview track 

play  button, you can see the track’s playing progress bar from 
Progress. 
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   Figure 3-3-4c   

Step 5 Enter a Description of the new VCD in the Description 
box(Figure 3-3-4d).  



 

 

Figure 3-3-4d 

Step 6 (optional) If the CD does not have an Auto-Run then you 
can specify a program to run when the VCD is inserted. You can 

use the Browse button to locate the executable program. 

Step 7 (optional) Choose whether or not to eject the CD from the 
CD drive once the Build is complete by checking the ‘Eject the VCD 
on completion of the Build process’ box (Figure 3-3-4d above). 
Click on Next to continue.   

Step 8 Click on Next to open the Build window. Virtual Drive will 
then display the attributes of the VCD about to be created.  
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Step 9 You can check the building process.  

Step 10 With the VCD is successfully built, click on OK to exit the 
Build popup then click on Finish to close the VCD Build window 

                                 
3.3.5 Conversion between an ISO 9660 image file and a VCD 
file  

You may convert an ISO 9660 image file into a VCD file as well as 
convert a VCD file into an ISO 9660 image file. 

Step 1 Select File on the menu bar, then select Convert from the 
drop menu to open the Convert file window.  

Step 2 Click the Browse button to open the Windows file browser. 



 

 

 

Step 3 Select the ISO/VCD file you want to convert, then select 
Open to continue. 

Step 4 Select Convert to start the conversion. 
 
Note: Audio VCD, DVD and compressed VCD file can't convert into 
ISO file. 
 
3.4 Managing VCDs in the VDN Server 
 
 
3.4.1 Adding VCD folders (CD Jukebox) 

Before VCDs can be added to the VDN Server, a Folder or CD 
Jukebox must first be created to hold the VCDs.   

Step 1 Click on VCD Folder located on the left side of the VDN 
Administrator program window. Then right click on the blank space 
in right panel of the VDN Administrator window. A popup menu will 
be displayed. Select “New Folder”.  
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(The same function can also run from the Menu bar by selecting 
'File' then 'VCD files') 

Step 2 Type in the new VCD folder Name and Description then 
click Create to add the folder. When you have finished adding new 
folders, click Cancel to close the dialog. 

 

Step 3 Save the new VDN Folder Configuration 

Save the new configuration by clicking on the "Save" 
button or click “File” on the Menu bar and select “Save”. VDN 
Clients will see the new configuration only after "Refreshing" their 
screen or restarting the Client program. 
 
3.4.2 Changing a VDN Folder Description 

Open the Folder Properties dialog by right-clicking on the folder 
and selecting Properties. Or, go to File -> VCD Folder -> 
Properties from the File menu. 



 

 

The Folder Properties dialog only allows the editing of the VCD 
folder description. 
 
 
3.4.3 Adding VCDs to a VCD Folder 

Step 1 To add VCDs to a VCD folder, first click on the VCD Folder 
name listed on the left side of the VDN Administrator program 
window. Then right click on the blank space in right panel of the 
VDN Administrator window. A popup menu will be displayed. Select 
“Add VCD”. 

(The same function can also run from the Menu bar by selecting 
'File' then 'VCD files') 

Select the files that you want to add to the VCD folder and then 
click “Open”. All of the selected VCD files will be added to the VCD 
folder. 
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Note 
Files selected from the Network Neighborhood are UNC 
compliant.  

   

Important !   
VCDs cannot be added to the VDN server Administrator 
from: 

- a local drive  e.g. C:\vcds\mykids play.vcd or a mapped 
drive  e.g. F:\math1.vcd (while f: is mapped to 
\\server\vdn) 

VCD files must be stored within 'Shared' folders and may 
be located on different file servers (as in a distributed 
network system).  



 

 

   

Tips 
To add multiple VCD files at a time. Hold down the Ctrl key 
and click on each VCD to select, or hold the SHIFT down 
key to select block of VCD files in the file list.  
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The added VCDs will appear in the Administrator window. 

Step 2 Save the new VDN Folder Configuration   

Save the new configuration by clicking on the "Save" button or 
Click “File” on the Menu bar and select “Save Configuration”. 
VDN Clients will see the new configuration only after "Refreshing" 
their screen or restarting the Client program. 

Note: The VDN configuration file is stored in the 
\\server\vdn\TvConfg.Bny. Before updating the configuration file, 
the VDN Administrator program will make a backup copy to 
“$TvConfg.nnn”. VDN maintains backups for the last 4 
configurations. 
 
 
3.4.4 Deleting a VCD Icon or VCD File 

Right click on the VCD icon and select “Delete” to open the popup 
menu shown below.  



 

 

Click OK to Delete the VCD icon from the VDN Administrator. Only 
the VCD icon displayed in the VDN Administrator is removed from 
the VDN CD server, the VCD file remains on the network and may 
be added to the VDN Server again. 

To delete the VCD file and its icon check the 'Delete VCD files in 
the disk' then click OK. This will remove the VCD icon from the 
VDN server and VCD file from the network. 
 
3.4.5 VCD properties & Custom Auto-run Function 

To view a VCD’s properties, right click on that VCD’s icon and 
select "Properties" from the drop menu to open the VCD 
Properties dialog box (shown below). A VCD’s description can be 
edited from here. 

Additionally, VDN provides a comprehensive way to startup VCDs 
created from CD-ROMs with no built-in Autorun feature. 

To set up an Autorun function for a VCD, simply follow these steps: 

Step 1 Check the “Run the command listed below when VCD is 
inserted” 

Step 2 Fill out the command line to include the path and the name 
of the program file to be run. 
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e.g.“\setup.exe”or"\mydocFolder1\myFile.doc" or 
"\mydocFolder1\myPage.htm" 

 

 

3.4.6 Searching VCD 

Step1 Select Search  button or select File from 
menu bar, then Search VCD from the drop menu to open 
Search VCD Box.   



 

 

Select VCD folder in Path drop menu or browse for folders by 

clicking on button. 

Click on Search, the files are being searched will be displayed in 
the window. Select a certain file or multiple files (by holding down 
CTRL) you have found, and click Add to put them into a folder 
(figure below). 
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Path: If "Search in VCD folder" radio box is selected, 

you can select a CD folder by clicking on button or in 
search path box(figure 3-4-6a); you may browse for 
folder from network drives by selecting "Search on 
Network"(figure 3-4-6b). 



 

 

f igure 3-4-6a 
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f igure 3-4-6b 

3.4.7 Software information 
 
Select Help and then About from the drop menu, the popup 
window will display the information about software license and 
version. 
 
 
3.4.8 License Manager  

To increase the user count, you need to buy additional licenses 
from FarStone. Select Help->License Manger. Then select Buy 
Additional Licenses to purchase licenses from FarStone over the 
Internet. Select Enter New License and enter the new license 
number in the text box and click Add License.  

 



 

 

 
 
 
3.4.9 Extracting files from VCD 
 
Users can access files from the VCDs without inserting them into 
the virtual drive. Click on a VCD icon in VirtualDriveTM tray, all its 
contents will be displayed in the bottom-right frame. Right click on 
the selected file and select Extract from the drop down menu. 
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Specify a folder to save the extracted file. 
 

 
 
 
 



 

3.5 Managing VCD access on the VDN Server 
 
3.5.1 Users and Groups – Overview 

A Group can be created to manage multiple users’ access to a VCD 
Folder.  

If you use Groups to manage access rights then you must create 
User Accounts for everyone using VDN and assign them to groups. 

3.5.1.1 Adding/Removing Users 

Add a new User by right-clicking in the Users and Groups frame 
then selecting New User from the drop menu to open the New 
User dialog(Figure below). 

 

Enter the User details and a Password if required. 
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Click Create to add the User, or Cancel to close the dialog. 

Finally, click on Save to save the new configuration.    

   

Note 
No period, blank, or characters as [\ / [ ] : | < > + = ：， ? *] can be 
included in the user name. 

The new user is added into guests group at default setting. Please 
refer to 3.5.1.2 Adding users to group if you want to assign 
users to another group. 

To remove a user select the User Name, right-click and select 
Delete from the popup menu.  

Adding/Removing Groups 

Right-click on the Groups icon and select New Group to open New 
Group dialog box. 



 

 

Give the New Group a Name and Description then click on the 
Create button(figure below). 
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To remove a group, you can either (a) right click the group and 
select Delete from popup menu or (b) select the group and press 
Delete key on keyboard. 
 
 
3.5.1.2 Adding Users to Groups 

Select the User Name right-click and select User Properties from 
the popup menu. In the popup box, you can either assign single 

user by using the button or assign all users by clicking on 

 button to any of the listed Groups. On the contrary, use 

or button to remove users from groups. 

You can then use the 'arrow' buttons to assign the User to any of 
the listed Groups. 



 

  

 

   

Note 
A user in a group has the same access as the group he is subject to.  

Changing a User Password 

Select the user’s name, right-click and select 'Change Password' 
from the popup menu. 
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Type the password and confirm it.  Click OK to finish. 

 

 
 
3.5.2 Sharing VCD Folder 

Users have access to the VCD files in VCD folders only if they have 
access privilege assigned by VirtualDrive administrator. 



 

To share a VCD folder to users, select a VCD folder, select 
File -> Share or right click on it and select Sharing. 

 
You can share the folder with users and groups by adding or 
removing them from right pane of the Window. 
 
 

3.5.2.1 New Sharing 

Right click on share VCD folder in left pane of VirtualDrive 
Administrator, select new sharing from the popup menu to open 
select folder window.  
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Select a folder in this window and click Next to enter the next step. 



 

 

If you want to share this folder with users or groups, add them 
into the right pane of this window. 
 
 
3.5.3 VCD License 

 
By using VCD license, you can specify how many users may access 
VCD files at one time. 
 
3.5.3.1 Set License for a VCD File 

You can set the license for a VCD file by (a) Selecting a VCD file 
and pointing to License->Set License on the file menu or (b) 
Right clicking on a VCD and clicking Set License from the drop 
menu, either method will open the license window (figure below). 
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The default setting is NO Limitation. You may change the license 
count by entering a number in the blank box. 

AS well, you may set VCD license number for a VCD folder and 
VCDs in it by repeating the process. 
 

3.5.3.2 View License 
 
You may inspect current license usage of a VCD file by (a) 
Selecting a VCD and pointing to License->View License on the 
file menu or (b) Right clicking on a VCD and clicking View License 
from the drop menu, either method shall open the window as 
below. 



 

 
VCD license information is displayed in this window, includes: VCD 
license number, the location of this VCD and who are using it. 
 
 
3.6 Viewing Client VCD Usage  
 
3.6.1 Viewing VCD Usage  

To view the usage of any particular VCD, click on the VCD name to 
select it then right-click and select Disc Usage History or click on 
File-> Disc Usage History to open the Statistic dialog. (shown 
below) 
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Note 
Statistic function can take effect only after enables  ->View-
>Settings->Other->Verify the authority for VCD folder in VDN 
administrator.  

 

Click on the Refresh button to Refresh the dialog and display the 
network usage statistics. 
 



 

3.6.2 Viewing User Statistics 

To view the statistics of any user, click on the name to select it 
then right-click and select Disc Usage History or click on File-> 
Disc Usage History to open the dialog (shown below). 

 

You may view the usage status in a period of time by appointing 
the date rage in the drop list. 

To back up the statistic result, click on Export and give a path to 
save the backup file. 
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3.7 Backing up VCD List 
 
Using this feature you can back up the information of current VCD 
list in VirtualDrive® and restore it at any time you want. 
Select File from VirtualDrive® Manger menu, then Backup to 
save the VCD list in the hard disk. 
 
 
3.7.1 Backing Up VCD list 

Using this tool you can back up the information of the current VCD 
list in VirtualDrive and restore it at any time you like. 

Select File from VirtualDrive MangerTM menu, then Backup to 
save the VCD list in the hard disk. 

  

 

Enter a location to save the backup file (*.vdl). 



 

 

 
 
3.7.2 Restoring VCD List 

Select File from VirtualDriveTM Manger menu, select Restore. 

 90 



  

 

Select the VCD list you want to restore and select Open. 



 

Chapter 4 VDN Command 
Program                           
 
 
4.1 VDN Command Program (VDRIVE.EXE) 

VDRIVE.EXE enables you to create shortcuts to Insert/Play or Eject 
VCDs. You can use the shortcuts as a quick and easy method of 
inserting VCDs. 

To launch VDrive.exe click Start on the windows taskbar then 
select: 

 /Programs/VirtualDriveNetwork/VirtualDrive Command. 
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Examples for Vdrive.exe: 

1. VDRIVE  D: \\Server\vcds\Age of Empires.vcd /I 

The above command will insert the “Age of Empires.VCD” from 
server into VirtualDrive (D:) and play it automatically. 

2. VDRIVE  1: \\Server\vcds\Age of Empires.vcd /I /M 

This command inserts the “Age of Empires.vcd” from server into 
the first VirtualDrive and launches its autorun program. 
 
 
4.2 Using the command line for creating shortcuts to 
run VCDs  

Using command line instructions is an ideal method for 
implementing customized shortcuts to run your VCDs. 

Step 1. Write down what you want the short cut to do. 

eg. Vdrive E: "C:\VCDCollection\Ages of King.vcd" /I 
@E:\Age.exe 

Vdrive •E:• "C:\VCDCollection\Ages of 
King.vcd"• /I •@E:\Age.exe   

"•" - shows where a blank space must be inserted 

The above example, read from left to right works as follows: 

Vdrive -Tells Windows that the following commands will be 
executed by vdrive.exe 

E: -selects VirtualDrive E: 

"C:\VCDCollection\Ages of King.vcd" -Adds the path and 
the name of the VCD file to load 



 

Note : Use brackets around the drive, path and file name of 
there are any spaces in the character string. 

/I -Tells the Vdrive program to load the VCD 

@ -Tells vdrive to run/execute a program 

E:\Age.exe-Tells vdrive where the program is by giving the 
path (E:) and the name of the file to run(Age of King.exe).  

Step2 Create a blank shortcut by right clicking on an empty space 
on the Windows desktop and select "New" then "Shortcut". The 
drop menus' shown below will be opened. 

 

Step 3 Enter the command line from Step 1 in the "Create 
Shortcut" Window( shown below) 
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Vdrive E: "C:\VCDCollection\Ages of King" /I @E:\Age.exe 



  

 

Chapter 5 VirtualDrive CD/DVD 
Burning Program        
 
VirtualDrive® combines the functions of CD/DVD emulation 
software with CD/DVD burning capabilities.  It allows users to copy 
CD/DVD images from the hard disk to a recordable medium.  

 
 

5.1 Copying disc 

With the Copy Disc function, you can combine the reading and 
writing processes.  You can create an image(VCD) from the source 
CD/DVD and copy it directly to a recordable CD/DVD disc.  The 
Copy Disc process consists of two main parts: the “Building 
Image” process and the “Copying Image” process.  The “Building 
Image” process allows you to create an image (VCD) of a source 
CD on your hard disk.  The Copying Image process allows you to 
burn the image file onto a recordable medium.  

To use the Copy Disc feature, Click on the  button on the 
VirtualDrive Manager toolbar or select Tools->Copy Disc from the 
menu bar to open the Copy Disc dialog.   

Step 1: Select a source disc to read from and then select Next.  

Step 2: Find your CD recorder from the dropdown menu, and then 
insert a recordable disc into the CD recorder.  Click the Device 
Info button on the right-hand side of the recorder to learn more 
detailed information about the CD Recorder and the inserted disc.  
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Note 
If you do have only one CD drive (CD recorder), you can insert the recordable 
disc later according to the system prompt after the “Building Image” process is 
completed. 

Before starting the “Building Image” process, you can specify the 
write speed to use.  The write speed you select will depend on the 
speed of your CD writer and the type of recordable medium you 
are using.  

We strongly recommend that you try a Test Burn before 
physically burning the image onto the re-writable disc.  The ‘Test 
Burn’ option lets users verify whether their devices are able to 
complete the burning process without ruining the disc.  The Test 
Burning does not actually write any data on the physical disc.   

There are other options on this page:  

• Number of copies: Set how many copies will be burned at 
this time.  

 

• Buffer under-run protection: Buffer Under-run errors are 
a common problem due to the lower transfer rate of data from 
the hard drive or CD/DVD reader to the CD/DVD recorder.  This 
function will prevent Buffer Under-run.  

• Finalize CD: This option lets users decide whether to close 
the last session of the re-writable disc or not. Checking this box 
will close the last session, which means that no further data 
can be written onto this disc after the burning process is 
finished.  If this option is not selected, data can be written on 
the disc next time if there is enough capacity on the 
disc.  However, we still suggest users enable this function, as 
some CD/DVD readers cannot read multi-session discs properly.  

• Verify data after Recording: Select this option to check 
whether the data on the CD/DVD is readable after recording. 



  

   

Step 3 Click the Record button to open the screen shown 
below.  Select the CD read method and use data compression if 
desired.  The default read method “Intelligent Extraction” is 
successful for most CD formats.  

Step 4 Enter a Description of the new VCD.   

Step 5 (optional) If the CD does not have an Auto-Run then you 
can specify a program to run when the VCD is inserted. You can 

use the Browse button to locate the executable program. 

Step 6 (optional) Choose whether or not to eject the CD from the 
CD drive once the Build is complete by checking the ‘Eject the 
VCD on completion of the Build process’ box (Figure .4-1b 
above). Click on Next to continue.  

Step 7 If you have only one CD drive (CD recorder), when the 
image has been successfully built, VirtualDrive will prompt you to 
insert a recordable disc.  Insert a recordable medium and click on 
OK to burn the image onto the disc.  

 
 
5.2 Copying images to a recordable disc 
 
Step 1 Use either of the following methods to open the 
VirtualDrive burning program:  

• Select Tools from the menu bar and then select Burn 
Image.  

• In VirtualDrive Manager, right-click on the VCDs you want 
to burn and select Burn Image from the dropdown menu.  

• Click button on VirtualDrive toolbar.   
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Step 2 All selected images (Virtual CDs) and their detailed 
information are displayed in this window.  You can also right-click 
in the above box and select Add/Delete from the dropdown menu 
to add new images or remove existing images. 

 
 
Step 3 After confirming the images to be burned, click Next to 
open the screen shown below: 



  

 
Find your CD recorder in the dropdown menu, and then insert a 
recordable disc into the CD recorder.  Click the Device Info button 
on the right-hand side of the recorder to learn more detailed 
information about the CD Recorder and the inserted disc.  
Before starting the “Building Image” process, you can specify the 
write speed to be used. ‘Best Speed’ means the maximum speed 
your CD writer supports. The write speed you select will depend on 
the capabilities of the CD writer and the recordable medium.  
We strongly recommend that you try a Test Burn before 
physically burning the image onto the recordable disc.  The Test 
Burn option helps users to determine whether their devices are 
able to complete the burning task without risking destroying a 
medium.  Test Burning does not actually write any data on the disc.  
There are other options on this page:  
 

• Number of copies: Set how many copies of the recordable 
disc will be burned.  
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• Buffer under-run protection: Buffer under-run errors are 
a common problem due to the lower transfer rate of data from 
the hard drive or CD/DVD reader to the CD/DVD recorder.  This 
function will eliminate Buffer Under-run.  

• Finalize CD: This option lets users decide whether or not 
to close the last session of the recordable disc. Checking this 
box will close the last session, which means that no further 
data can be written onto this disc after the burning process is 
finished.  If this option is not selected, data can be written on 
the disc next time if there is enough capacity on the 
disc.  However, we still suggest users enable this function 
because some CD/DVD readers cannot read multi-session discs 
properly.  

• Verify data after recording: Select this option to check 
whether the data on the CD/DVD is readable after recording.  

Step 6 You can check the burning progress.  After the burning 
task is completed successfully, click on OK to finish the process.  

 
 

5.3 Erasing a Disc  
 
Erase Disc enables users to delete the data on a re-writable 
CD/DVD.  
Please do the following to erase a disc using VirtualDrive burning 
program.  
 
Step 1 Select Tools from the menu bar and then Erase to open 
the Erase Disc screen.  



  

 
Step 2 Choose the CD recorder in which a re-writable disc is 
already inserted.  

 
Step 3 Choose an Erase Mode from the dropdown menu.  
 
There are two Erase Modes in the dropdown menu:  

• Quick Erase: Discs erased using this option appears to be 
empty but data is not physically removed.  A quick erase 
will take a short amount of time to complete and will only 
erase the Table of Contents (TOC) of the disc.  The erased 
data may be recovered using some special tools.   

• Full Erase: Full Erase will physically erase the whole disc.   
Compared to  Quick Erase, Full Erase will take a longer 
time to complete.   

Step 4 Click Erase to begin to erase the disc.  
 
Step5 The CD/DVD device will auto-eject after the erasing process 
is complete. 
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5.4 Viewing Device Info 

The Device Info provides the detailed information of the installed 
CD/DVD device and the inserted CD/DVD.  

Select Tools from the VirtualDrive menu bar and then select 
Device Info from the dropdown menu to display the device 
information.   

 

   

There are three buttons on top right side of the Device Info page:  

 

 



  

 
Refresh current device information.  

 
Save your current device information as a text file on your hard disk.  

   

 

Send an e-mail about your device information to FarStone 
Technology.  This feature will be helpful for users to collect their system 
information and report it to FarStone technical support when errors occur 
when they are using VirtualDrive.     
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Chapter 6 Using the VDN Client 
Program                      
 
 
6.1 Starting the VDN Client Program 

To launch VDN Client program, you can either (a) right click on the 
“VirtualDrive” icon and select "VirtualDrive Network client" or (b) 
click on ->start->programs->VirtualDrive Network->VirtualDrive 
Network client. 

 

 

                                                     
6.2 Running Virtual CD-ROMs (VCDs) 
 

There are several methods of inserting a VCD file. If the VCD has 
Autorun this will be run when the VCD is inserted. 



  

Click the Virtual Drive tab on the right-hand-side of the VDN 
window to display all Virtual Drives. 

Once in this view, there are several methods for Inserting a VCD. 

Method 1 Clicking on the VCD then the "Insert" button  will 
open a list of available drives. Select a drive to insert the VCD. 

Method 2 Double clicking on the VCD icon. will open a list of 
available VirtualDrives. Select a drive to load the VCD. 

(note: If only one VirtualDrive has been created, double-clicking 
on the VCD will automatically insert the VCD into this drive.) 

Note: See VDN Administrator VDrive.exe feature to create a 
custom Autorun VCD 

Method 3 Left click on the VCD and with the mouse button still 
de-pressed, drag the VCD icon onto a Virtual Drive icon. 

Method 4 Highlight a VCD icon and select "insert" from "edit" drop 
menu. 

Method 5 Select a VCD icon then press "insert" button on 
keyboard. 

Method 6 Right click on a VCD icon and select "insert" from the 
popup menu will open a list of available drives. Select a drive to 
insert the VCD. 

6.3 Ejecting a VCD  

Click the Virtual Drive tab on the right-hand-side of the VDN 
window to display all Virtual Drives. 

Once in this view, there are several methods to Eject a VCD. 
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Method 1 Right click on the inserted VCD and select "Eject 

Method 2 Click on the VCD then click on the "Eject"  
button.   

Method 3 Click on the icon and with the mouse button still de-
pressed drag the icon into the right-hand-side frame.  

Method 4 Click on the inserted VCD icon and press "Delete" key 
on the keyboard. 

Method 5 Highlight a inserted VCD icon and select "eject" from 
"edit" drop menu. 

Method 6 Right click on the VirtualDrive and select eject from the 
popup menu. 

 

6.4 Viewing VCD Properties 

To view the VCD properties, point to a VCD icon and right click to 
open the VCD properties window (shown below).  VCD properties 
cannot be edited from within the VDN Client program. 
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6.5 Searching VCD 

Search VCD let users to search for VCDs being shared by 
the VDN Server.  Select File->Search or use hot key Ctrl+F 
to open Search VCD File window (figure below). 



  

 

Select VCD folder in Path drop menu or browse for folders by 

clicking on button. 

   

Note 
You can fill the Name field to narrow the search to VCDs with similar 
filename.  Use * as wildcard to match a search pattern. 

Select Search, the searched files will be displayed in the window. 
Right-click on the VCD file and select Insert to insert into a Virtual 
Drive. 
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6.6 Setting the Number of Virtual Drives  

To change the Virtual Drives in your system (the maximum is 23), 
select "Drives" from the “View” menu to open the VirtualDrives 
dialog (Figure 5-6a). Check the drive letter for each Virtual Drive 
that you want to Add/Remove, and then click OK to finish.  

 

                                           5-6a 

   

Note 
Drive letter A, B, C, and D are normally reserved for Windows to use.  
Check with your I.T. Administrator to see if any drive letter is reserved 
for future uses in your organization before allocating Virtual Drives.  

 
 
6.7 Updating changes from the VDN Server 
 



  

If you know that the Administrator has made changes to the CD 
Server, the VDN Client program can be updated to reflect these 
changes by either restarting the Client program or selecting 'View' 
then 'Refresh' on the Menu bar.  Or click on the Refresh icon. 
 
 
6.8 Settings 

To open the Administrator Settings dialog, select File on the menu 
bar then Settings. 

 

The available Toolbar settings are described below: 

Use large Icons: Sets the size of the buttons icons on the toolbar. 

Show Button Name: Sets the number of text characters to be 
displayed within the toolbar buttons. 

Show Tool Tips: Sets whether to display control tips popup, when 
the mouse pointer hovers over a toolbar button. 
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Use Flat Toolbar Buttons: Merges the toolbar button “outline” 
into the toolbar. 

Customize: Clicking on 'Customize' button, opens a dialog 
offering a selection of buttons available within the VDN 
Administrator. From here you can add/remove or change the order 
of toolbar buttons used on the VirtualDrive toolbar. 

Animation ON/OFF 

Set the VCD Insert/Eject animation ON or OFF.   

 

  

Device Information 

Modify the manufacturer name, driver model and edition directly 
for your virtual drive.   



  

 

  

Other Settings 
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Show VirtualDrive splash screen at startup: The VirtualDrive 
Manager will display the VirtualDrive logo when the program loads. 

Keep VCDs inserted when restarting: VCDs that were inserted 
into any Virtual Drive on shutdown will be inserted at startup. 

   

Note 
this function will not be available if you use Verify the authority for 
VCD folder to manage access rights to VCDs by Users and Groups. 

Add VirtualDrive icon to the System Tray: The VirtualDrive 
icon will be added to the bottom right hand side of the Windows 
taskbar.



 

Chapter 7 Uninstalling 
VirtualDrive® Network                   
 
 
7.1 Uninstalling VirtualDrive® Administrator Program 
Group 

Step 1 click on Next to continue: 

Step 2 Click on Remove to begin removal. 

Step 3 Click on Finish to complete. 

Step 5 With the VirtualDrive Network program files removed, click 
on Yes to reboot your system and have the changes effect. 

 

The uninstall program will purge all files created by VirtualDrive 
Network except files ending with the extension 'VCD'. Your Virtual 
CD-ROM files can be deleted using the Windows Explorer. If you 
keep these files, they can be manually added to the VDN Server if 
you reinstall the VDN Administrator. 
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7.2 Uninstalling VirtualDrive® Client 
 
Repeat the above process on the client PC. 
 
7.3 Uninstalling VirtualDrive® Network Server 

Step 1 To uninstall VirtualDrive Network Server, select 
Start/Settings/Control Panel and double click on the 
Add/Remove Programs icon to open the Add/Remove Programs 
dialog, select VirtualDrive then click on the Add/Remove button. 

 

Step 2 To confirm uninstall, click on OK. 

 

Step 3 Click on Finish complete uninstall. 



  

Chapter 8 Appendix                                            
 
 
8.1 Notes: 
 
Server Setup: (Peer-to-Peer network) 

Create a new shared directory on the administrator (or teachers) 
computer. (for example: \\server\shared\vdn) 

Note: You may want to select multiple clients as administrator 
workstations. Install the administrator program to as many clients 
as you want.    

 

Note: To share a directory, use “Windows Explorer” to browse your 
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hard drive, right click on the folder (for example c:\vdn), select 
“Sharing” 
 
8.2 FAQ 

Q1: Why cannot I fail to install VDN Administrator 
or VDN Client, or these two components cannot 
work properly? 

Please check the following three points and retry: 
1. Make sure VDN Server has been installed 
successfully. 
2. Make sure the two shared directories of VDN Server 
have been set correctly(More detail about the share 
setting, please refer to Installing the VDN Server 
Overview ).  
3. Make sure the computer of VDN Server has started 
up. 

Q2: Why the time for building protected CD is 
much longer than building other sorts of CDs? 

You must build protected CDs with intelligent 
extraction, otherwise the building is hard to finish 
because it cost overmuch time or the VCD is 
unreadable after the building. Another reason for this 
phenomenon is that at the beginning of the building, 
VirtualDrive slows down the speed while reading data 
from some protected area on the CD (as laserlock, 
safedisk, securom), so the time estimate to finish will 
be prolonged. The VirtualDrive will speed up once 
finish the building on this area and the time remains 
will be reduced as well. 
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Q3: Does the building time vary depending on the 
quality of the real CD-ROM drive? 

The reading speed of CD-ROM drives produced by 
different manufacturer diverse varies a lot due to 
their error-correction ability and other mechanisms. 
Therefore, the building speed mostly depends on the 
quality of CD-ROM drive instead of VirtualDrive 
program. 

Q4: Can I convert a VCD file, which is built by 
intelligent extraction,  into a ISO file? 

The standard of the VCD file that built by using 
Intelligent Extraction is different from ISO file. So it 
can't be converted into a ISO  file.   

Q5:  Does VirtualDrive support IEEE1394 or USB 
CD-ROM? 

VirtualDrive 7.03 or later version support IEEE1394 or 
USB CD-ROM. If you still possess the old version, you 
can download the newer one from our website. 

Q6: VirtualDrive auto-plays the contents of virtual 
CD at system start-up. How can I stop the auto-
play? 

Uncheck Enable CD autorun box from View-> 
Settings -> Miscellaneous settings in VirtualDrive 
menu bar. 



  

Q7: Can VirtualDrive automatically eject all 
inserted VCDs from virtual drive(s) after the 
computer restarted? 

Yes, just uncheck Keep VCDs in drive when 
system boots box from View->Settings-
>Miscellaneous settings in VirtualDrive menu bar. 

Q8: Why does the game application still ask me to 
insert the CD when the virtual CD is already 
inserted?   

  You may resolve this problem by trying either of the 
following methods: 

         a. Change a CD drive ‘s drive letter by 
using  “Disk Management” in Windows: right-click My 
Computer->Manage->Disk Management, right click 
the interested drive, select "Change Drive Letter and 
Paths" to change drive letter. 

    b. Build this game CD by using intelligent 
extraction. 

Q9: Why does the system always prompt that 
‘Please insert a disk into drive….’ after I insert a 
VCD (built from Mixed-Mode CD) into a virtual 
drive? 

 The problem may be caused by the file Filter Driver 
in the application Ahead Nero 5.5.6.4. The Filter 
drive is not compatible with VirtualDrive, it makes 
VirtualDrive unable to read data on VCDs with sound 
tracks. You can resolve the problem by uninstalling 
Nero from the Computer. 
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Q10: Why the maximum number of virtual drive is 
23? 

There are 26 letters in alphabet. We suppose that A: 
and B: are floppy drives on your computer, C: is the 
entire hard disk, and therefore there are 23 letters 
left (D-Z), each one can be assigned to a drive. So 
you can create at most 23 virtual drives. 

Q11: Does VirtualDrive support protected game 
CD? 

The answer is yes, VirtualDrive supports various 
protected game CDs as: Mixed-Mode protected, 
Safedisk1，Safiedisk2，Securom，Laserlock, etc. 

Q12: Why can’t I hear the background music 
while playing game? 

The background music of some mixed-mode CD is 
available only if the CD is inserted in the first CD-ROM 
on the system. 

Q13: Some games require more than one CD for 
playing. How can I replace CD without 
interrupting the game? 

VirtualDrive enables users to use hot-key to insert a 
CD. Preset a hot-key and virtual drive for the CDs and 
you can insert them into the designated drive by 
using the hot-key without stopping the game. 



  

Q14: What sort of CD need to be built by using 
‘Intelligent Extraction’? 

Some protected CDs as Securom should use 
intelligent extraction to build. 

Q15: After I set the number and position of 
virtual drives on WindowsXP/2003 Server, 
VirtualDrive regards virtual drive as real CD-ROM 
drive. How can I correct this? 

There are two ways to resolve this problem: (1) 
Restart your computer (2) Refresh in Device Manager 

Q16: The drive letter of real CD-ROM was 
arranged to the tail. How can I change the drive 
letter sequence? ( e.g. change F: to E:) 

You can assign a drive letter to a CD-ROM drive by 
the following steps: 

Windows 2000/XP/2003 Server only 

（1）Right click on ‘my computer’ from desktop, 
select manage --> disk management . 

（2）Make sure which one is virtual drive. 

（3）Right click on virtual drive icon, select ‘change 
drive letter or paths’ from the drop menu. 

Q17: Can two or more administrator programs 
exist in a local area network? 
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 No, only one administrator is allowed to exist in a 
local area network. 

Q18: I do not want somebody to see the shared 
VDN directory via My Network Places, how can I 
hide it? 

You can keep the directory invisible on a network by 
renaming the folder name as VDN$. 

Q19: What should I do prior to installation if I 
want to install VDN Server on Windows 2000? 

You need to download Microsoft Data Access 
Components (MDAC) from Microsoft website and 
install MDAC on the target computer. After that, VDN 
Server can be installed successfully. Without MDAC, 
the VDN Server will fail to complete the installation.  

Q20: What if I see the following message during 
the installation VDN Server:"Error: 2008. Failed to 
update SQL express 2005 configuration, please 
refer to FAQ or contact our technical support"? 

Please uninstall SQL Express 2005 manually from the 
control panel and retry.  
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